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1. Introduction. 

VO2max Finder ergospirometer is a stationary module system for effort examination 

of the respiratory and circulatory systems which enables a comprehensive analysis of the 

conducted measurements. VO2max Finder measuring system was constructed on the basis 

of the pneumotachographic head patented by MES and fast analysers of carbon dioxide and 

oxygen which enable the measurements with the 'breath-by-breath' method and the analysis 

of every breathing-out stage. The system may be optionally equipped with the stirring 

compartment.  
Thanks to the modern pneumotachographic head the measuring system does not require the 

inhalation-exhalation valve or other connections of the corrugated pipe type. It ensures full 

comfort during the test because the person examined breathes in natural conditions without 

the additional resistance for the air flow. In accordance with the ERS/ATS guidelines, the 

inbuilt spirometric examination module with unique software that provides the reliability 

control of the conducted examination ensures determining the FEV1, MEF 50, VC values 

on the basis of which the norm values of HR, VO2, VE measured in an effort examination 

are determined automatically. 
VO2max Finder enables to constantly register in time the following signals: breath volume, 

breath flow, O2 and CO2 in the exhaled gas, 1-12 ECG leads. The system always records the 

full course of examination so that it would be possible to re-create every exhalation. The 

manner of presentation of the course and the printout of the course of the measured changes 

and calculated values is defined by the operator.  
Advantages of the VO2max Finder system: 

- examination with the breath-by-breath method 

- light, low-resistance pneumotachographic head without moving elements 

- automatic system of measuring the environment conditions 

- automatic system of calibration of gas analysers 

- alternative way of measuring the pulse with the wireless system or with 12 ECG 

leads 

- automatic or manual determination of the anaerobic threshold 

- possibility of VO2max calculation 

- presentation of the measured items on the background norm values 

- automatic steering of the moving tracks or bicycle ergometers 

- possibility of editing the printout form of the examination report 

- possibility of examination report transfer to the standard statistical programmes 

- software compatible with Microsoft Windows 

- easy transport of the system installed on a trolley 

- possibility of measuring system expansion with additional options: pulsoxymetry, 

minute heart projection with the non-invasive method, systolic and diastolic 

pressure measurements. 
 

VO2max Finder system consists of the following items: 

1. VO2max Finder Ergospirometer 

2. Pneumotachograf head-piece 

3. Mouth-piece  

4. Ergospirometry face-mask with head-cap 

5. Calibration gas bottle 

6. Gas Reducer for the bottle 

7. Connection pipe Reducer-Ergospirometer 

8. Bottle holder 

9. PC computer with Windows system. 
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10. Monitor. 

11. Printer 

12. Keyboard 

13. Mouse 

14. POLAR receiver  

15. 3-tube air cable  

16. Software CD 
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Ill. 1. VO2max Finder Ergospirometer. Its view from the front and back side. 

VO2max Finder Ergospirometer is equipped with the following ports and elements:  
 

1. USB plug for PC connection.   

2. Power plug for power supply 230-240V,50Hz 

3. Two connectors: FLOW IN and FLOW EX for 3-tube air cable 

4.  ET connector for gas tube (3-tube air connector) with blue stripe 

5. GAS connector do podłączenia butli lub worka z gazem kalibracyjnym 

 

I 
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6. CAL connector – for the silicone tube coming from 3-tube air cable (by the side 

of the head-piece) 

7. ON/OFF switch 

8. Gniazdo HR – for connection with POLAR reciever 

9. LED diodes which give information about: 

- turning on the device (green) POWER 

- getting the device ready to work and heating up the sensors (yellow) READY 

- activation of HR and possible alerts (red) STATUS 

 
 

The FLOW EX connection terminal. One should there connect the cable from the 

pneumotachographic head marked with a black ring. One should connect the other cable to 

the IN connection terminal. 
 The ET connection terminal is dedicated to connect the gas cable marked with a 

blue ring. The GAS EX should be left open (outlet to the atmosphere). 
 During the gas calibration the GAS connection terminal (quick connector) should be 

connected to the reducer of the sample gas cylinder. 
 Connection called CAL is used during the gas calibration. It should be connected to 

the silicone cable from the pneumotachographic head connector.  
 

  VO2max Finder program, that cooperates with VO2max Finder ergospirometer, 

enables to conduct the spirometric examination. The program interface is presented in 

Ill. 2. The programme allows for determining the following parameters: 
 

BF [1/min]                      breathing frequency;  

HR [1/min]                     heart rate per minute; 

MET = VO2/kg/3,5       metabolism unit (1MET=3.5ml/min/kg); 

VE [litre/min]                 minute ventilation – air volume that the patient's lungs   

  ventilated during 1 minute. The parameter is calculated as the   

  product of the number of breaths (BF) multiplied by the volume   

  of a single breath (TV) measured during the exhalation. BTPS   

  conditions.   
 

RER = VCO2/VO2         respiratory equivalent;  

TE [s]                 exhalation time; 

TI [s]                 inhalation time; 

TTOT [s]                total time of respiratory cycle; 

TV(VT) [litr]                volume of a single breath; 

VO2 [litr/min]               oxygen consumption in relation to the STPD conditions; 

VCO2 [litr/min]            carbon dioxide exhalation in relation to the STPD conditions; 

FeO2 [%]                average value of oxygen accumulation in the breathed-out air  
                                          (value calculated like FeCO2); 

FeCO2 [%]                average value of carbon dioxide accumulation in the   

   breathed-out air. The value is calculated for every breath; in case  

   of average determination for a given period of time, it is counted  

   as a mean value of all the average values of full exhalations in a  

   given period of time. 

EQO2 = VE/VO2        ventilation oxygen equivalent; 

EQCO2 = VE/VCO2  ventilation carbon dioxide equivalent; 

TI/TE [%]                ratio of inhalation time to exhalation time; 

TI/TTOT [%]                ratio of inhalation time to total cycle time; 
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VO2/HR [ml]     oxygen consumption in relation to the frequency of heart rate  

   per minute;  

VO2/Kg [ml/kg/min]    oxygen consumption in relation to 1 kg of the patient's body  

   mass;   

VO2/Kg/HR [ml/kg]    oxygen consumption in relation to 1 kg of the patient's body  

   mass and the heart rate frequency unit; 

WATT [W]    load; 

PEF [l/s]    peak value of exhalation flow; 

PIF [l/s]    peak value of inhalation flow; 

FETO2 [%]   maximum oxygen accumulation in the exhaled air measured in 

the final sample of the exhaled air; 

FETCO2 [%]   maximum carbon dioxide accumulation in the exhaled air 

measured in the final sample of the exhaled air; 

SpO2    saturation (blood saturation with oxygen); 

VD/VT   ratio of dead space to the respiratory volume; 

PEO2 [mmHg]  average partial oxygen pressure in the exhaled gas; 

PECO2 [mmHg]  average partial carbon dioxide pressure in the exhaled gas; 

PETO2 [mmHg]  partial oxygen pressure in the final sample of the exhaled gas; 

PETCO2 [mmHg]  partial carbon dioxide pressure in the final sample of the exhaled 

gas; 

BR [%]   breathing reserve; 

VET_SUM [L]  volume of the ventilated air; 

TV_TE [L/s]   ratio of the TV parameter to TE; 

Speed [km/h]   Moving track speed; 

Slope [%]   Moving track slope; 

SBP [mmHg]    value of the systolic blood pressure; 

DBP [mmHg]   value of the diastolic blood pressure; 

Borg    20 point Borg scale with which the patient describes   

   independently their own subjective perception of work exertion; 

Points Work 
6 Extremely light 

7 

8 Very light 

9 

10 Quite light 

11 

12 Quite hard 

13 

14 Hard 

15 

16 Very hard 

17 

18 Extremely hard 

19 

20 

 

Lactate [mmol/l]    value of lactate concentration in blood; 
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Values describing oxygen debt: 
 

VE.B.SUM [L]  total volume of breaths during the test calculated with the 

reference phase level (tare);  

VE.T.SUM [L]  total volume of breaths during the whole test; 

VE.L.SUM [L]  total volume of breaths during the exertion phases; 

VE.R.SUM [L]  total volume of breaths during the rest phases; 

VO2.T.SUM [L]  total quantity of oxygen used during the whole test; 

VO2.OD.SUM [L]  difference in the quantity of consumed oxygen during the 

exertion phases between the consumption quantities rounded to the 

level of the phase ends and the real values; 

VO2.L.SUM [L]  total quantity of the consumed oxygen during the exertion  

   phases; 

VO2.R.SUM [L]  quantity of the used oxygen in the rest phase; 

VO2.A.SUM [L]  VO2.A.SUM = VO2.OD.SUM - VO2.R.SUM; 

VO2.B.SUM [L]  quantity of oxygen used during the test calculated with the  

   consumption level from the reference phase; 
Explanation of the used abbreviations STPD, BTPS, ATP: 

STPD     Standard Temperature Pressure Dry (conditions of dry gas in  

   the temperature of 0 oC and pressure of 760 mmHg); 

BTPS     Body Temperature Pressure Saturated (a man's body   

   temperature, atmospheric pressure and humidity of air saturated  

   with water vapour); 

ATP     Ambient Temperature Pressure (conditions of temperature,  

   humidity and pressure in the room where the test is conducted). 

1.1. Technical data.  

General data: 
Measurements (length/width/height)  670/520/850 mm 
Supply voltage    220 V (AC) 

 Power consumption    150 VA 
 

Technical data of the measuring module: 
 

Flow measurement: 
Measurement head:   MES of DV40 type 
Dead space:    40 ml 
Flow range:    +/- 18 l/s 
Consumption resolution:   +/- 10 ml/s 
Volume measurement range:  0 - 10 l 
Consumption resolution:   10 ml 
Measurement accuracy:   < 2% 
Measurement head resistance: < 0,9 cmH2O/l/s (at the flow of 12 l/s) 
Measured ventilation range:  300 l/min 
 

Oxygen analyser: 
Conductance 
Measurement range:   0 – 100 % 
Response time:    t90 < 50 ms  
Accuracy:     0,1 % 
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Resolution:   0.01 % 
 

Carbon dioxide analyser: 
NDIR infrared absorption 
Measurement range:   0 – 15% 
Response time:    t 90< 90 ms  
Accuracy:     0,1 % 
Resolution:    0,01 % 
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2. Installation. 

To conduct the examination properly, one need to install the VO2max Finder set properly. 

Installation consists in the following steps: 
 

1. From the attached CD-ROM install the Start 2000/Finder program on the computer: 
 Start the setup.exe file in order to launch the Start 2000/Finder program 

installer. Install the program. 
 Reset the computer. 

2. Install the USB drivers from „USB Drivers” of your CD.  
3. Connect the mains cable to power supply port of the device. The other end of the 

cable plug to the mains socket with 230-240 V, 50Hz.  
4. Connect the cable between the device and free USB port of the computer.   
5. Connect air tubes to connectors FLOW EX. 
6. Connect POLAR to the POLAR socket. 
7. Find the “Device Manager” in your system. Find “Port COM&LPT section. You 

should see 4x USB Serial Port (COM x).  
8. Right click on the first port and select “properties”. Select “Port Settings” tab and 

press “Advanced” button. Change the “Delay time” from 16 to 2ms. Accept changes 

with OK. 
9. Repeat previous point for next 3 ports.  
10. Launch the Start 2000 program from Menu Start -> Programmes or from Desktop. 
11. Conduct the examination according to the description from Chapter 7. 
12. When there is a communication breakdown between the computer and the 

ergospirometer, one should check the cable connections to the ports.   
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3. Programme interface description. 

 

Ill. 2. Programme interface. 

The programme window is presented in Ill. 2. It basically consists of two parts 

divided by the so-called splitter. Splitter allows to modify the height of individual parts. In 

order to do this, one should: 

 click on the splitter with the left mouse button; 

 drag it to the desired position;  

 drop the splitter by releasing the mouse button.    
Additionally, interface includes menu ( Chapter 10), toolbar ( Chapter 11) and status 

line ( Chapter 11.3). The window has different toolbars depending on the fact whether the 

programme opened a finished examination from the file, an examination for on-line test, or 

an examination for off-line test.       
The first part includes the views of diagrams of parameters calculated during the 

examination and the the view of on-line processes. The number of both view types is set in 

the programme options ( Chapter 5.4.1). It is possible to have maximum 4 views. They 

are also divided by Splitters. The programme offers a selection of parameters diagrams of 

which we would like to display in a given view ( Chapter 6.5.1.2). The maximum number 

of diagrams in one view is four. Every diagram is in different colour. The diagram refers to 

the parameter whose name (at the top of the diagram) is displayed in the same colour as the 

diagram. Also the colour of scale on the Y axis determines the diagram it refers to.  
The programme saves the data collected during the test. After the examination is 

finished, on the current parameter diagrams there appears Scroll, that is a narrow bar at the 

top of the diagram with a bar. By sliding the bar we may display data from any moment of 

the examination. The window width (the length of the time period presented in the view) is 

set in the view settings (Chapter 5.4.1). In the parameter diagram one can also turn off the 

Scroll. One turns it on by a mouse double-click on the view. One turns if off in the same 

way. The slide can also be made with the L (left) and R (right) keys. They slide the diagram 

left or right by a whole window. Active diagram is marked with a blue frame at the top and 

the right side of the view.  
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The second part includes a table with the values of the selected parameters from the 

consecutive moments of examination. Which parameters and moments are displayed can be 

set in the table view settings ( Chapter 6.5.4). If the window size exceeds the available 

screen area, there appear in this window scrolls with bars on the right side and at the bottom 

of the window. They allow to slide the window vertically and horizontally so that the 

desired fragment would be displayed.        
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4. Patient's data 

The patient's data is a set of information required for the patient's identification. 

Without this information no examination can be conducted. The patient's data can be 

entered in two ways: 

1. Entering new patient's data ( Chapter 4.1). 
2. Opening the file with the results of examination previously conducted on a 

patient ( Chapter 7.4). 
After entering the patient's data, the examination will be conducted for this patient. In order 

to examine another patient, first one needs to enter their data.  

4.1. New data 

Patient's new data is entered by means of the dialogue window: Patient's data ( Ill. 

3) available after selecting the Patient's data command (menu File). The window opens a 

set of fields where one should enter information according to the labels next to each field.   

 

Ill. 3 Dialogue window: Patient's data. 

4.2. Modification 

The patient's data modification can be done only before the examination beginning. 

After the examination beginning, the modification of the incorrectly entered and accepted 

data requires shutting down of this examination and launching a new one. One should then 

enter the correct data in accordance with the procedure of entering a new patient ( 

Chapter 4.1). The dialogue window: Patient's data includes patient's data from the last 

opened examination in the programme (regardless of the fact whether the examination was 

opened from the file or it was a new examination).   
The patient's data modification before the beginning of the examination can be done 

by means of the dialogue window: Patient's data ( Ill. 3) selecting the Patient's data 

command (menu File). The data modification is possible only after its previous entering ( 

Chapter 4). All patient's data can be modified.  
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4.3. Data survey 

The patient's data survey, that is the survey of its content on the day of performance 

of the open examination, is conducted after selecting the Patient's data command (menu 

File). Before the examination starts, it is possible to modify this data ( Chapter 4.2), and 

after its start or reading the examination from the file, it can only be surveyed.    
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5.  Programme options 

Programme options include information necessary for the proper conduction of the 

examination. They refer to the parameters of data transfer between the ergospirometer and 

the computer, and to the examination parameters. The examination options are available in 

the menu Tools.  

5.1. Environment conditions 

Upon selecting the Environment conditions command, there appears a dialogue window 

referring to the external conditions during the examination ( Ill. 4). 

 

Ill. 4. Atmospheric conditions. 

Not giving or giving the wrong parameter values about the temperature, humidity and 

pressure may lead to the distortion of the examination results. Those values can be entered 

manually reading them from the external appliances (thermometer, barometer, hygrometer) 

or by means of automatic reading. In order to do this, one needs to connect to the computer 

a special add-on device for reading the weather conditions, and then (after launching the 

Start 2000/Finder programme) mark the field Turn on in the Automatic reading group. A 

Series port COM window will become activated where one should select the number of port 

to which the add-on device has been connected. By clicking the Read now button, the 

reading of the current atmospheric conditions will be made and the values will be entered 

into the dialogue window. This data can be updated both before and after the selection of 

the examination type ( Chapter 7.2). It is valid for 4 hours. It means that for 4 hours from 

entering the data the programme will not require the weather conditions update, regardless 

of the fact whether the programme was launched once or several times during this period of 

time.  
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5.2. Calibration 

After the selection of the Calibration command one needs also determine whether 

the calibration refers to gas or to volume. If the programme is launched without current 

atmospheric conditions, there will appear a dialogue window for their updating ( Chapter 

5.1). One should enter the current values of temperature, pressure and humidity or select the 

automatic reading of those values (if we have at our disposal the add-on device for the 

automatic reading of those conditions). Gas and volume calibration is valid for 24 hours. 

Calibration should be made in the ATP conditions.   

5.2.1. Volume calibration 

After selecting the Volume calibration command from the submenu Calibration in the 

menu Tools and possible updating of the current atmospheric conditions (if there appears a 

dialogue window referring to this), there will appear a dialogue window as shown in Ill. 5. 

 

Ill. 5. Volume calibration. 

In the Calibration manoeuvre group in the Number field one should enter the number of 

correct movements of the calibration pump piston which finish the calibration. In the 

Irregularity field we enter the irregularity percentage of the pomp piston movement. 

Exceeding it causes that the programme rejects the manoeuvre whose irregularity exceeded 

the set percentage. This percentage is calculated from the average volume of all previous 

movements. Therefore, it is possible to reject the manoeuvre that was previously accepted. 

In the Calibration pump group in the Capacity field we give the volume of the used 

calibration pump. Before one starts calibration, one obviously has to connect the calibration 

pump to the spirometric head which is properly attached to the air cable connector. 

Calibration is started by clicking the Start button and there is a steady movement of the 

calibration pump piston. In the Calibration factor field there is displayed the last correct 

calibration factor, and in the Number of steady manoeuvres field there is the number of 

movements accepted by the programme. In the Manoeuvre volume window there are 

displayed columns whose height indicates the volume of the performed manoeuvre. The 

number of columns corresponds to the number displayed in the Number of steady 

manoeuvres field. At the bottom of the window there is a field where the 'prompting 

messages' are displayed which facilitate the process of calibration. When in this field 
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appears information that the calibration has been completed successfully, the process of 

volume calibration is finished. 

5.2.2. Gas calibration. 

The dialogue window for gas calibration ( Ill. 6) will appear after selecting the Gases 

command from the submenu Calibration in the menu Tools.  

 

Ill. 6. Gas calibration. 

This calibration may be summarised in the following points to be performed in a strictly 

determined order: 

In the Sample gas parameters group one should enter the O2 and CO2 concentration 

percentage in the sample gas (description on the calibration gas cylinder). Changes can be 

made only after connecting a new sample gas cylinder.  

1. After clicking the Start button there appears information that 'zero' will be read 

from the atmosphere. One should make sure that the end of the silicone gas cable 

(by the head connector) is 'let out' to the atmosphere. Then we confirm this with the 

OK button.  
2. For the next 30 seconds 'zero' will be read from the atmosphere.  
3. After reading 'zero', the programme will inform that the sample gas calibration will 

be conducted. Then one needs to connect the bag or cylinder with calibration gas (if 

it is not already connected) to the socket CalGas(Ill.1,D)of the device. The end of 

the gas cable (the one 'let out' in point 2 to the atmosphere) should be connected to 

the socked showed on the Ill.1,I(outlet of the calibration gas).    
4. The connection is confirmed with the OK button. The proper calibration process 

lasts also around 30 seconds. During the process the following information are 

displayed in the window: 



Operating manual for VO2max Finder system 
. 

 

 20 

a) In the Currently read concentration group there are displayed the currently 

read concentrations of the proper gases. 
b) In the O2 – cylinder reading and CO2 – cylinder reading columns are 

drawn whose height corresponds to the values from the Currently read 

concentration windows.  
c) At the bottom there is a field where the 'prompting messages' are displayed 

that facilitate the process of calibration. When in this field appears 

information that the calibration has been completed successfully, the 

process of gas calibration is finished.  

d) In the Calibration Factors field the calculated calibration factors are 

displayed.  

5.2.3. Gas calibration (high O2) – OPTION. 

This type of calibration is used for examination with stabilisation. It is similar to the 

standard gas calibration; the difference lies in the fact that the oxygen concentration in the 

examined gas is much higher than in the standard calibration (around 50 %). What is more, 

carbon dioxide (CO2) is not included in the calibration. The calibration process itself is 

conducted in the same way as the standard gas calibration; at the end of calibration the 

calibration factor for oxygen is calculated and it may be saved.   

5.2.4. Oxygen sensor calibration (additional oxygen sensor – OPTION).  

This calibration concerns the oxygen sensor located on the bag with inhalation gas 

during the examination with oxygen stabilisation. Dialogue for calibration is presented in 

Ill. 7. 

 

Ill. 7.  Oxygen sensor calibration. 

At the bottom of the window there are prompts that facilitate the calibration process. One 

should follow these instructions; 
 

In the Sample gas concentration field we enter the known concentration of the examined 

gas. The oxygen sensor is put in the atmosphere, then we press the Start button – reading 

'zero' from the atmosphere starts. During this and other stages at the bottom of the window 
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there is displayed a progress bar informing about the duration of the given stage. 

Additionally, in the prompting field there is displayed information about the current stage of 

calibration. After reading zero from the atmosphere one needs to put the gas bag on the 

sensor, and then click the Start button one more time. Then there is a stage of reading 

sample gas when in the O2 – reading columns are drawn whose height corresponds to the 

read concentration. After its completion the calibration factor will be calculated 

automatically, and the user will be informed whether the calibration has been completed 

successfully or not (it is successfully completed when the factor fits into the range of 0.8 to 

1.2). After the calibration has been completed successfully, the OK button is activated 

which causes saving the calculated calibration factor and closing the window. In order to 

perform another calibration, one needs to press the Next calibration button (earlier it is the 

Stop button). Calibration may be stopped in any moment with the use of the Stop button. In 

order to close the window, press the Cancel button.   

5.3. Equipment configuration. 

After selecting the Equipment configuration command from the Tools menu, there 

appears a dialogue window with three pages. The first one, Ergometer, concerns the 

examination options related to the ergometer; the second one, Communication, includes the 

parameters related to the ergometer communication and other devices with the computer; 

the third one, General, determines the directory path for saving the examinations and the 

manner of power calculation on the basis of slope and speed of the moving track. All 

parameters set in here are saved in the programme. It means that after closing and opening 

the programme again the previously set parameter values will be still valid.   

5.3.1. Ergometer. 

The Ergometr page is presented in Ill. 8. 

 



Operating manual for VO2max Finder system 
. 

 

 22 

 

Ill. 8. Ergometer dialogue window. 

In this window we determine the type of ergometer we work with during the examination. 

In one moment there may be only one or none of the fields marked. Marking any of them 

causes blocking all the others. By de-marking the field, we have the possibility of marking 

any field. Available fields are: Tapped control, MES control and No ergometer. By marking 

the Tapped control field and selecting the tapped device type we select the option of 

downloading the current load to the programme by reading it off the ergometer. The MES 

control field is dedicated for the selection of ergometer which we intend to control during 

the examination. Using this option one needs to set the examination phases before its start. 

In the No ergometer field we determine whether (if there is no ergometer) the phases should 

be set before or after the examination. If we decide that the phases should be set before the 

examination, the programme will not allow starting the examination when there are no 

phases designed and will remind us of this. If we select the option of setting the phases after 

the examination, upon finishing the examination there will automatically appear a dialogue 

window about the examination phases. If we do not mark any of the fields, we select the 

examination type which does not require any ergometer and we do not have to give the 

load. During such examination the load value in the WATT column will amount to '0'.   
The Type of load with no ergometer type selected field is dedicated to determine 

what type of load we are dealing with if there is no ergometer type selected. This 

information is necessary to calculate the VO2 norm.   
 

5.3.2. Communication. 

The Communication page is presented in Ill. 9. 
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Ill. 9. Communication dialogue window. 

In this window we determine the port numbers to which the tapped ergometer and 

control ergometer are connected. If there is no communication with any of these devices, 

one should check first of all whether the set numbers correspond to reality. While closing 

the window we confirm all the changes with the OK button. In the HR Source field we 

determine the type of device from which we read the HR value. If we choose Pulsoxymeter 

at the examination start, the OksyTest 1000 programme is launched which transmits the HR 

value to the programme. Similarly, if we select the Polar and Cardiax options, the Polar 

and CRX with Cardiax programmes will be launched respectively. Additionally, the 

selection of the Cardiax option is necessary if we want to read other cardiographic 

parameters. The detailed description of the cooperation with Cardiax can be found in 

Chapter 6.11. If during the test we use the Monark 829 bicycle as an ergometer, we have a 

choice of HR signal from the bicycle. Up to the 1.6.0.0 version the HR from bicycle or 

moving track was read only after the control phase. From the 1.6.0.0 version this parameter 

is read also during the control phase. The necessary condition for reading the HR parameter 

from the bicycle or moving track is the choice of the proper source in the menu and the 

choice of controlled ergometer in the Ergometer tab for the right bicycle or running 

machines (which transmit the HR parameter, e.g. Monark 829, 839, h/p/cosmos). 

5.3.3. General. 

The page General is presented in Ill. 10. 
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Ill. 10. The General dialogue window. 

On this page in the Directory with saved examinations field we give the access path 

to the directory where we wish to save the examinations. This path may be entered 

manually or created automatically. Automatic path creation occurs in two cases. The first 

one is when the default path is set. We do this by clicking on the Default button. Default 

path is: c:\mes\Wyniki badań\ (c:\mes\Examination results\). In the second case the path is 

created in the directory selected in the dialogue window that appears after the Browse 

button. This window is presented in Ill. 11. 

 

Ill. 11. Dialogue window: Browsing in search of the directory. 



Operating manual for VO2max Finder system 
. 

 

 25 

After marking the selected directory and confirming this with the OK button, in the editing 

window there is displayed the path to the selected directory.  
In the Manner of power calculation for the moving track field we determine which 

formula to use in order to calculate the power on the basis of the moving track's speed and 

slope. It is used in the examination with the controlled ergometer if it is a moving track. We 

have the following formulae to choose from: 
 JAEGER: 
 

 for running:  
W [Watt] = (V * BW * (2.11 + G * 0.25) + 2.2 * BW - 151) / 10.5 

 for walking: 
W [Watt]= (V * BW * (2.05 + G * 0.29) + 0.6 * BW - 151) / 10.5 

 

 ATS: 

G = 100 * tan   

W [Watt] =  BW * V * sin  * 100 / 36.4 
 

 BRUCE: 

tan   sin      for small   
W [Watt] = BW * V * G / 36 

 

Abbreviations used in the above formulae stand for: 
BW –  patient's body weight [kg] 
V    –  moving track's velocity [km / h] 
G    –  slope [%] 
W   –  load [Watt] 
 

 When we mark the Read SpO2 field upon starting the examination, the OksyTest 

1000 programme is launched which transmits the parameter value to the programme. The 

suitable module is necessary for this purpose.  
The System with three-way valve field should be marked if the three-way valve is used in 

the examination.  
 

5.4. Examination option. 

5.4.1. Document layout. 

The Document layout page is presented in Ill. 12. 
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Ill. 12. Dialogue window: Document layout. 

In the Window layout in the view group we determine the number of all views in the part 

dedicated to diagrams ( Chapter 3). The minimum number is one, maximum – four. How 

many of those views will be the on-line type views is determined in Number of On-Line 

Diagrams. In the Height percentage for the table field we determine the percentage of the 

whole window interface to be covered by the table. The Scroll range for diagrams 

determines the period of time in seconds that will be visible on views with the scroll turned 

on. If we mark the Include the due in Table field, in the table of  the values of parameters 

which are due, they will be displayed in the colour dependent on the value and due relation. 

If the parameter value ranges between the minimal and maximal due value, then the cell has 

the sea-green colour. Sample fragment of the table including the dues is presented in Ill. 13. 
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Ill. 13. Table including dues. 

5.4.2. General. 

The General with Examination Options page is presented in Ill. 12. 
 

 

Ill. 14. Dialogue window: General with Examination Options. 
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With the Read spirometric parameters at start field marked, at the examination start 

the programme tries to read the patient's spirometric parameters. If there are any, they will 

be read and the parameter creation date will be checked. If they were created more than a 

month before, the user will be informed which parameters are concerned and when they 

were created. If there are no spirometric parameters of the patient, the user will also be 

informed about it.  
If the Indirect calorimetry field is marked, the energy consumption will be 

calculated with the indirect calorimetry method, otherwise the calorimetry will be 

calculated from the minute ventilation.  
Marking the Calculate calorimetry option enables to calculate the energy 

consumption during the examination. If this option is de-marked, the consumption will not 

be calculated despite the occurrence of examination conditions for the calculation.  
The Display the cause of test ending dialogue after examination option causes that 

after the examination there will be automatically displayed a window where we can give the 

cause of ending the test.  
Marked Show SBP/ DBP/ Borg/ Lct window with phase change introduces the 

automatic display of dialogue dedicated for entering the values of these parameters for 

examination. The window can also be opened with the SBP, DBP, Borg, Lct Entry 

command from the Tools menu or with the use of this icon: . 

5.4.3. Stabilisation (OPTION). 

The template is dedicated to determine the parameters of examination with stabilisation.  

In the Stabilisation method field one should select the type of stabilisation that one would 

like to exploit during the examination. The Oxygen stabilisation field determines the set 

oxygen concentration in the breathed-out gas during the stabilisation. In the Air stabilisation 

field we set the temperature in which the inhalation gas should be kept. Below we set the 

flow values from the air reducer and from the oxygen reducer. One should give those values 

accurately, because it significantly influences the quality of keeping the set oxygen 

concentration. In order to set those flows accurately, one should use the Open buttons. They 

open the electro-valves from air and from oxygen, which enables to set both flows and enter 

their values. Then there is a place for entering the gas volume for preparation. It is the 

amount of gas that would fill the gas bag before the examination start. Obviously, this 

amount should be smaller or at least equal to our bag's capacity. At the end we determine 

the port numbers that are used to read the sample gas parameters and to control the 

stabilisation device. 

5.5. User and Service. 

The User command produces a dialogue window with queries about the User's 

Login and Password (. 15).   
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Ill. 15. The User dialogue window. 

After entering the right key words, the User has access to certain options of the programme 

which are normally unavailable. It is used by the programme's service men.  
 The Service order is available for an average user. It is also used by the programme's 

service men.  
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6. Conducted examination options. 

6.1. Examination stages. 

Every examination consists of two stages: control stage and examination stage. 

During the control stage there are actions performed to prepare the ergospirometer for work. 

It includes resetting its memory and ventilation of the measurement system. When those 

actions are completed, the programme enters the analysis state in the control stage whose 

values are not saved. One should then check if the programme operates properly and if the 

parameter rows are added to the bottom table. During the examination stage we perform the 

proper examination which is divided into three parts: reference (resting), exertion and rest 

(restitution). During both stages the successive parameter values appear both on the diagram 

and in the table at time intervals determined with the Averaging parameter (Examination 

options -> Document view – Chapter 6.6). 
 

NOTE !!! 
1). The control stage is crucial for the correct performance and receiving reliable results in 

the proper examination stage, because in this stage the processes of ventilation and resetting 

the measurement system are conducted. During this process the pneumotachographic head 

connection cable must be as far as possible from the mouths of the patient and the operating 

personnel, because the great sensitivity of measuring systems of ventilation and exhalation 

gas concentration may lead to reading and saving the false zero of the module of ventilation 

and CO2/O2 gas analysers.  
2). In the control phase of the stage when the programme launches the analysis system, the 

three-way air connection cable must be connected to the pneumotachographic head installed 

to the measurement mask previously put on by the patient. The third cable of the three-way 

air cable, marked in blue, must be connected to the connection terminal installed in the 

mask connector.  
 

6.2. Examination phases. 

The dialogue window referring to the examination phases is produced by the Examination 

phases command from the Examination menu. This command is available only for the open 

document (new examination or examination opened from the file). This window is 

presented in Ill. 16.  
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Ill. 16. Examination phases. 

 

Examination phases include information about the test parameters for the whole 

time of examination. The information are: phase name, its duration, load received by the 

patient, and speed and slope of the moving track (if it is used for the examination). The 

examination may consist in any number of phases.  
The window basically consists of three parts. The first one includes the list of all 

phases and their parameters. The second part includes fields to enter the data. The third part 

includes buttons used to edit the phases. While entering a new phase, one needs to 

determine both the X and Y parameters. The phase name is set by default as Phase no. x 

where x stands for the successive number of phase. But this name may be changed to any 

name. The X parameter is the phase duration time. In the Y parameter field we may enter 

the load, or the speed and slope of moving track during the given phase. Which field is 

active depends on the settings in Examination options on the Ergometer page ( Chapter 

5.3.1). If we select the option of tapped ergometer, none of the fields will be active because 

the load is read from the ergometer. The same situation takes places if no field is marked. If 

the examination uses the ergometer control, then in case of a bicycle the active field will be 

Load and in case of a moving track the active fields will be Speed  and Slope. By marking 

the Phases with no ergometer field one may enter the Load. If one enters to the phases the 

speed and slope of the moving track, then in the Calculated load there is displayed load 

calculated according to the formula set in Examination options on the General page ( 

Chapter 5.3.3). The load is entered to the phase while adding the phase.  
The Add button is dedicated to enter the set phase. Delete deletes the phase marked 

in the phase list. We mark it by clicking the left mouse button on the name of the selected 

phase. Delete all deletes all phases from the list. Change allows us to change the selected 

phase's parameters. The Save button saves the set of phases from the list in a file of the 

given name. The standard file extension is *.phs. The Read button is dedicated to load the 

phases from the file. In order to confirm the entered data we use the OK button. During the 

programme installation on the computer in the C:/Mes/Phases directory the files with the 

most popular examination programmes are saved. They are: 

1) Weber; 

2) Repty; 

3) Naughton Modified; 

4) Cornell; 
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5) Bruce Modified; 

6) Bruce; 

7) Acip Modified; 

8) Acip; 
The programme often requires for examinations setting the phases before the 

examination starts. This requirement concerns examinations using controlled ergometer and 

in case of the selection of the Phases set before examination option from the Phases with no 

ergometer field (Examination options -> Ergometer – Chapter 5.3.1). When we choose the 

Phases set after examination option, the programme will require entering the examination 

phases right after the examination ends and automatically display the window related to 

examination phases.   
The Load real phases button is dedicated to loading the real phases created 

automatically during the examination on the moving track. After pressing, the button name 

changes into Load project phases. It is dedicated to loading the project phases. If there are 

no real phases in the examination, then the phase field will be empty. While saving the 

examination, both real and project phases are saved.  
Marking the Auto Stop option causes the automatic ending of the examination when 

all the project phases are completed.      

6.3. Events. 

An event is a blue vertical line which marks the examination characteristic moment. 

The event is entered with the Enter event command from the Examination menu. The 

relevant dialogue window is presented in Ill. 17. 
 

 

Ill. 17. Event dialogue window. 

The event is entered when the examination is conducted. In the Name field one should enter 

the name of the event, and in the Commentary field – the description of the situation that 

occurred. In the time field there is displayed the moment of examination when the event 

was entered. We confirm this entry withe the OK button. The dialogue window presented in 

Ill.. 18 is used for event editing. 
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Ill. 18. Event editor dialogue window. 

It is possible there to change and delete events entered during the examination. The editing 

concerns the event marked on the event list (top dialogue window). Marking and de-

marking is done with the left mouse button. The OK button is used for confimation. From 

the 1.5.0.0 programme version the events are displayed also on the on-line diagrams.   
An event may also be entered after the examination. If we have a row marked in the 

table, then after giving the Enter Event command the above dialogue will be displayed with 

the set time from the marked row. Additionally, oen may enter the event from the Event 

editor dialogue and from the diagram menu.   
 

6.4. Remote control to the ergometer. 

This remote control enables us to control the ergometer. The remote control is 

presented in Ill. 19. 
 

 

               Ill. 19. Remote control to the ergometer. 

We may control it manually or with the help of phases. If we control the ergometer with the 

help of phases, it is possible to skip one phase and move to the next one. We do this by 

clicking the Next phase button. If we move beyond the last phase, the controlled device is 
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stopped. The Last button id dedicated to moving to the beginning of the last phase. In order 

to lengthen the duration time of the currently operated phase, one should use the Hold 

button. Moving to the next phases will be blocked then until the button is released. During 

the blocking the button changes its name to Release. Unblocking the phase moves us to the 

phase that is after the blocked one. If we select manual control, there is a possibility of 

changing the speed and slope. There are buttons that change these parameters by the value 

displayed on the given button. The parameters cannot be reduced to the value below zero. 

Additionally, the manual control offers the possibility of stopping the moving track. In 

order to do this, press the Stop button. After that the button name changes into Start. 

Another click causes the start of the moving track with the last set values of speed and 

slope. The button name changes again into Stop. At the bottom part of the remote control 

there are fields that have the current values of speed and slope. When the moving track is is 

stopped with the Stop button, they include the last set values. When the control is changed 

from manual to phase control, the values of speed and slope are changed to those that are 

set for the phase conducted during at the time of change. In case of manual control the time 

determining the phase to be conducted is constantly running. If we go back to control with 

the help of phases, there will be activated the phase that corresponds to the change time. If 

the last phase is completed, the moving track is stopped. If the control is changed from 

automatic to manual, the current values of speed and slope are the last values set by phases.   

6.5. Diagram view. 

The programme offers two types of diagram views. They are views of parameter 

diagrams and the course on-line views. Sample diagram view is presented in Ill. 20.  
 

 

Ill. 20. Diagram view. 

The sample view includes the diagrams of four parameters. It presents the maximum 

number of parameters in one view. Which parameters should be displayed in the view is set 

in the reference menu in the diagram view ( Chapter 6.5.1). Every diagram is drawn in 

another colour. Which Y axis corresponds to which diagram is determined by the Y axis 

colour. Similarly, the diagram in a given colour is the diagrma of the parameter whose name 

is displayed in the same colour as the diagram. In case of on-line views the X axis is the 

time axis and is common for all diagrams. In the parameter diagram the X axis parameter 

may be any parameter. Additionally, the active diagram is marked with a blue frame at the 

top and right side of the view. It will affected by the commands of stretching/ narrowing the 

scale of the vertical and horizontal axis and synchronisation of the table and other 

parameters. The diagram is activated by clicking on the selected diagram with the left 

mouse button.       
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6.5.1. Reference menu of the diagram view. 

One may set here options referring to the diagram display in the given view. It 

appears after clicking with the right mouse button on the selected view. The menu is 

presented in Ill. 21. 
 

 

Ill. 21. Diagram view options menu. 

6.5.1.1. Show events. 

Marking the Show events field (so-called 'tick') means that this option is activated. It 

displays the events entered during the examination ( Chapter 6.3). Marking and de-

marking this option is done by selecting this command.  

6.5.1.2. Parameters. 

In order to determine which parameters should be displayed in a given view, one 

should select the Parameters command from the menu in Ill. 21. There will appear a 

window as presented in Ill. 22. If the selected view is of the on-line type, then the window 

will have different parameter list.  
 

 

Ill. 22. Dialogue window for selecting the parameters for the diagram view. 

One may select the maximum of four parameters for each view. If we try to select more 

than four parameters, the programme informs about exceeding the allowed number and does 
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not allow marking another one. In order to mark another parameter, one should de-mark one 

of the already marked parameters. The parameters are marked and de-marked by clicking 

on the selected parameter with the left mouse butoon (in the field on the left of the 

parameter name). The Min. number button is dedicated to mark the minimal number of 

parameters (one parameter). De-marking is also done from the top of the list until only the 

minimal number of parameters is marked. The selection of parameters is confirmed with the 

OK button. 

6.5.1.3. Predicted values. 

Marking this option causes that in the given view there are displayed due values of 

the parameters. There are displayed due values of parameters that have such due values. 

Due values take the shape of two lines which mark their bottom and top limit. Those lines 

are drawn in the same colour as the parameter diagram. Displaying the dues concerns both 

the Y and X axis parameters. The sample view with the due values is presented in Ill. 23. 
 

 
 

Ill. 23. View with marked due values and anaerobic threshold. 

6.5.1.4. Type of diagram. 

This command allows us to choose between the line and point diagram type in the 

given view. 

6.5.1.5. Print the diagram. 

 Selecting this command results in printing the given diagram view.  

6.5.1.6. Enter AT threshold. 

It consists in manual placing the indicator (Chapter 6.5.1.9) in the place where we 

think that the anaerobic threshold is. In the selection field there appears an orange vertical 



Operating manual for VO2max Finder system 
. 

 

 37 

line that marks this threshold. The programme looks for the breath that is closest to this 

place during the load phase. In the table the anaerobic threshold is marked with larger bold 

and underlined font (only in case of averaging by breath). This option is available only if 

the examination is completed and the number of phases in the examination is bigger than 

one.  

6.5.1.7. Show AT threshold. 

It results in displaying in the given view the anaerobic threshold (if it has been 

determined). The view with the threshold displayed is presented in Ill. 23. 

6.5.1.8. Background colour. 

This option allows us to change the background colour of the given diagram. 

6.5.1.9. Indicator. 

Marking this option results in displaying on the diagram a thin vertical line that is 

the indicator. It is used to select the place where we would like to place the Event or the 

anaerobic threshold. While surveying the diagram content with the indicator  in the 

programme status line we receive information on the phase conditions of the examination 

(which phase was conducted, how much time was left to its completion, how much time 

was left to the examination completion). Obviously, information about the phases if 

displayed only if there are any phases in the examination. The information refers to the real 

phases.   

6.5.1.10. Enter event. 

This command results in entering the Event into the examination in the place where there 

currently is the indicator.  

6.5.2. Diagram options. 

6.5.2.1. Change of axis scale. 

In order to change the axis scale use the command from the View menu: Streching the X 

scale, Narrowing the X scale, Stretching the Y scale, Narrowing the Y scale. Thos 

commands are repeated in the toolbar buttons with the (+/-) magnifiers with the right scale 

marked . Stretching the Y scale is possible for all the diagrams, while 

stretching the X scale is possible only for the diagrams with Scroll (on-line diagrams and 

parameter diagrams with activated Scroll). Those operations affect the active diagram. The 

smallest possible X axis scale is restricted to 10 seconds.  
 



Operating manual for VO2max Finder system 
. 

 

 38 

6.5.2.2. Synchronisation of the table with the diagram. 

This command (View menu) is dedicated to set the table in the time place (its Scroll) in 

which the diagram is active. This option refers to diagrams with Scroll. The command is 

repeated in the toolbar . 
 

6.5.2.3. Synchronisation of diagrams with the diagram. 

This command (View menu) is dedicated to set the other diagrams with Scroll in the time 

place in which the diagram is active. This option refers to diagrams with Scroll. The 

command is repeated in the toolbar . 
 

6.5.2.4. Default X scale range. 

This command (View menu) is dedicated to setting in all diagrams with Scroll the same 

scroll range (set previously in the options – Chapter 5.4.1). The command is repeated in the 

toolbar . 
 

6.5.3. Table. 

Sample table is presented in Ill. 24. 
 

 

Ill. 24. Parameter table. 

The table presents the values of the selected parameters at the given moments of the 

examination. When the size of the table exceeds the available screen area, there appear 

scrolls with bars at the bottom and on the right which enable to display any fragment of the 
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table. If we mark the Include dues in the Table field one the View page in Examination 

options (Chapter 5.4.1) in the value table of parameters that have dues, they will be 

displayed in the colour depending on the value and due relation. If the parameter value lies 

within the range of minimal and maximal due value, then the cell will be sea-green (normal 

value). In other cases, it is white. If the HR parameter is incorrect, four horizontal dashes 

are displayed there. 

6.5.4. Table view options. 

Table view options are available in the context menu that appears after clicking on 

the table view with the right mouse button (Ill. 25).  
 

 

Ill. 25. Table view menu. 

If we mark the table row (with the left mouse button) while surveying the table content, we 

receive in the programme status line the information about the phase conditions of the 

examination (which phase was conducted, how much time was left to its completion, how 

much time was left to the examination completion). Obviously, this information is 

displayed if there are any phases in the examination. The information refers to the real 

phases.  

6.5.4.1. Parameters. 

The parameters displayed in the table are selected from the dialogue window which 

appears after choosing the Parameters displayed in the Table command from the View 

menu. The window can also be opened by clicking on the Parameters command in the table 

menu. The window is presented in Ill. 26.  
 

 

Ill. 26. Dialogue window for the selection of parameters in the table. 

In the window with the parameter names we select those that we would like to display in the 

table. Marking and de-marking is done by clicking on the selected parameter with the left 
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mouse button (in the field on the left side of the name). One may switch the parameters' 

place (they will be displayed in the table in this order). In order to do this we click on the 

selected parameter with the left mouse button and drag it to the desired position.  
The Max. number button is used to mark the maximal number of the available parameters 

(in the present version it is 20). Marking is completed from the top of the list until the 

maximal number of marked parameters is reached. The Min. number button is used to mark 

the minimal number of parameter (2 parameters). De-marking is also done from the top of 

the list until there is only the minimal number of parameters marked. The selection is 

confirmed with the OK button. Print results in printing the table with the printer. 
The parameters from which examination moments appear in the table is determined by the 

selected averaging ( Chapter 6.6).     
 

6.5.4.2. Remove / Restore. 

The programme offers the possibility of removing the rows from the table if we 

suspect that there was some interference. The remove and restore option is possible only if 

the rows are averaged by breath. In order to remove a given row, one needs to highlight it 

with the left mouse button and then select the Remove/ Restore command from the table 

menu. Then the highlighted row turns grey and the parameter values of this row change into 

the average value from the previous and next rows. On the printout the removed row is 

marked in bold italics. In order to restore the original row, we act in the same way as with 

removing (highlighting the removed row). While saving the examination, the original and 

removed rows are recorded, so it is possible to restore the original rows in the examination 

saved with removed rows. It is possible to remove or restore several rows at a time. One 

should highlight several rows with the use of the Shift key and the left mouse button and 

then select the Remove/ Restore button. Within the highlighted area the removed rows will 

be restored, and those that are not removed will be removed.    
 

6.5.4.3. Enter event. 

This command allows to enter an event in the time represented by the highlighted 

row. In order to do this, one needs to highlight the row in the table with the left mouse 

button and then select the Enter event command from the table menu. There will appear a 

dialogue window for entering the Event with the set time of the highlighted row.  

6.5.4.4. HR editing. 

This command allows to edit the HR parameter in the highlighted row. It is 

available only with averaging by breath. In order to edit the HR parameter, one need to 

highlight the row and select the HR editing command from the table menu. There will 

appear the dialogue window that contains the old parameter value. One should modify the 

value and confirm this with the OK button. (Ill. 27). 
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Ill. 27. HR editing dialogue window. 

6.5.4.5.  Pop-Up window. 

It is the window where the given parameter is displayed during the examination. 

The parameter is displayed in a very large font, which enables the observation of its value 

from afar. We select the parameter by clicking the left mouse button on the window area 

which presents us with the parameter selection menu. We may select only one parameter 

(i.e. in order to mark the selected one, one should de-mark the one previously marked). It is 

not possible to select the time and ordinal number parameters. The command for displaying 

the Pop-Up window is available in the View menu and on the toolbar.  

 

Ill. 28. Pop-Up window. 

6.5.4.6. Synchronisation of diagrams with the table. 

This command (available in the View menu) results in setting all the diagams with 

Scroll in the time place where the highlighted table row is. The table row is highlighted by 

clicking on it with the left mouse button. 

6.5.4.7. Table printout. 

By selecting the Print Table command from the View menu or pressing the Print 

button in the parameter dialogue window (Chapter 6.5.4.1) we print only the table with the 

printer.  

6.6. Averaging. 

If we select the Data averaging command from the View  menu there appears a 

window as presented in Ill. 29. 
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Ill. 29. Dialogue window: Averaging the results in the table.  

Here we select the averaging method the data read during the examination. The programme 

saves the data after the patient's each breath, so it is possible to change the averaging 

method for the examination opened from the file. If we select by breath method the 

parameter value will be the value for the given patient's breath. If we select any of the 

times, then the parameter value is the average of its values from the selected time period. 

With the change of the averaging method there also changes the number of samples that are 

displayed in the table and in the diagram, because their number depends on the period of 

time from which their average value is calculated (from by breath to every 5 min.). 

Therefore, the averaging method change changes the outlook of the displayed diagrams and 

tables. If we select the by phase method, the averaging will be made according to the 

periods of time of the individual phases. On the right we determine the phases according to 

which the averaging is made. If we select averaging according to the real phases and there 

are no real phases, the programme will notify about this fact and average the data according 

to the project data. If there are no phrases set, then the option of averaging according to 

phases is inactive.   
 

6.7. Zeroing the flow and gases. 

To operate properly the measurement systems have to be zeroed before every 

examination. Zeroing is conducted automatically in the starting moment of a new 

examination. It can also be launched from the menu with the Flow zeroing and Gas zeroing 

commands.  

6.8. Export to the statistical programmes. 

This command orders the programme to convert the open document into a text file 

with the format that enables its reading and processing in the Microsoft Excel spreadsheet. 

Since it is a text file, it can be even modified with the simplest word processor (e.g. 

Notepad from the Windows' Accessories). The converted file is saved in the directory from 

which the document was opened and has the *.txt extension. The file name is identical with 

the name of the examination that we want to convert. 
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6.9. Last parameters LT. 

This command is used to display the last spirometric parameters for the given 

patient (not the ones saved with the examination). If there are no parameters, the 

programme informs the user about this fact.  

6.10. Show predicted values. 

Selection of this position from the Tools  menu displays the available predicted 

values for the given patient. If there are no predicted values, the user is informed about this 

fact.  

6.11. ECG parameters. 

The programme enables reading the HR parameter during the examination. It is necessary 

to have the ECG signal source, e.g. Cardiax, POLAR or other device.  
The programme reads the HR parameter while operating if one of the sources is marked in 

the HR source group in the Communication tab in Examination options.   
 

 The ECG Cardiax system is an independent device (look: Cardiax manual), but it 

can also operate together with the ergospirometer.   

6.12. Predicted values. 

The programme calculates the predicted values for four parameters. They are: VO2, 

HR, MVMAX, BR. In order to cacultate the norm for the last two, the spirometric parameter 

MEF50 is necessary. One can obtain it from the spirometric examination (Chapter 7.2.3). 

Those norms are calculated according to the Wasserman standards. Calculated values may 

be: 
- displayed (Chapter 0) ; 
- included in the diagram (Chapter 6.5.1.3); 
- included in the table (Chapter 5.4.1) 

  

6.13. Find the AT threshold. 

This command is located in the Tools menu (during the open examination). It is 

dedicated to automatically find the examination moment that is closest to the anaerobic 

threshold criterion. If such moment cannot be found in the examination, the programme 

informs the user about this fact.  
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6.14. Remove the AT threshold. 

This command is located in the Tools menu (during the open examination with the 

AT threshold marked). It removes the previously marked or found threshold from the 

examination.   

6.15. Indirect calorimetry. BMR norm configuration. 

In order to calculate the energy consumption, one should mark the Calculate 

calorimetry option in the General tab in Examination options. The energy consumption 

determined during rest or exertion is calculated with two methods: direct or indirect. The 

direct calorimetry method is the most accurate and requires expensive instruments, 

therefore few institutes use it. The indirect calorimetry method consists in calculating the 

energy consumption with the help of the analysis of oxygen consumption during the 

exertion which should last minimum 5-6 minutes because in such a period of time the 

functional equilibrium is achieved. Total energy consumption consists of three elements: 

- basic metabolism necessary to provide basic living functions which depends on the 

body surface of the examined person and the non-fat body weight – 60 75 %; 

- specific dynamic food actions – 10  15 %; 

- energy consumption during motor activity related to everyday actions – 15  30 %. 
In order to conduct the BMR norm configuration, click on the BMR norm configuration 

command in the View menu. A dialogue window (Ill. 30) will appear where one should mark 

the selected norm author: 
 

 

Ill. 30. BMR norm configuration. 

Formulae for the BMR values: 
 

Harris Benedict: 
Men: [kcal/day] = 66 + 13.75 * weight + 5.0 * height – 6.76 * age 
Women: [kcal/day] = 65.5 + 9.56 * weight + 1.85 * height – 4.68 * age 
 

Owen: 
Men: [kcal/day] = 879 + 10.2 * weight 
Women: [kcal/day] = 795 + 7.2 * weight 
 

Miffin: 
Men: [kcal/day] = 5 + 10 * weight + 6.25 * height – 5 * age 
Women: [kcal/day] = - 161 + 10 * weight + 6.25 * height – 5 * age 
 

where: 
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weight [kg]; 
height [cm]; 
age [years].   
 

6.16. Calorimetry based on the minute ventilation. 

 

It is not always possible to determine the energy consumption on the operating place with 

the help of the classic indirect calorimetry method. In the practice of industrial examination 

there is often used a method based on the results of the lung ventilation measurement. There 

is a high correlation coefficient and almost linear relation between the oxygen consumption 

during exertion and the minute ventilation value. The approximate value of the energy 

consumption may be calculated with the use of Datta-Ramanathana equation: 
 

 

  REE(EE) = 0.21 x VE(STPD)  [kcal/min] 

 
 

where VE(STPD) – lung ventilation in L/min in the STPD conditions (volume of dry gas in 

the temperature of 0oC and the atmospheric pressure of 760 mmHg). 
In order to calculate the calorimetry with this method one should mark the Indirect 

calorimetry in Examination options -> General. In order to convert the value from one 

method to another, one needs to mark and de-mark the above-mentioned field and issue the 

Convert calorimetry command from the View menu.  
 

6.17. Commentary. 

To the examination we may add the commentary that would characterise it. In order to add 

commentary one should select the Commentary command from the Examination menu. 

There will appear a dialogue window to enter the commentary (Ill. 31). 
 



Operating manual for VO2max Finder system 
. 

 

 46 

 

Ill. 31. Window to enter commentary. 

The information entered should be confirmed with the OK button. The commentary is saved 

with the examination. In order to read the saved commentary, one needs to select the 

Commentary option from the Examination menu.   



Operating manual for VO2max Finder system 
. 

 

 47 

7. Conducting the examination. 

7.1. Preparation for work. 

1. Check if the ergospirometer is connected to the DIO card port or RS 232 

port in the computer. 
2. Check if the pneumotachographic head is properly connected to the device 

( Chapter 1). 
3. If the examination is conducted with the use of controlled ergometer, 

connect it to the proper computer port ( Chapter 5.3.2).   
4. Connect the mouthpiec to the pneumotachographic head or the 

pneumotachographic to the mask . 
5. Launch the ergospirometer with the W1 mains switch. 
6. Start the Start 2000/Finder programme. 
7. Set the programme options ( Chapter 5). 
8. Conduct the examination according to the description from Chapter 7.2.  

7.2. Conducting the examination. 

The necessary condition for the test start is checking if all the measurement elements of 

the device function properly. The check is possible thanks to the procedure of calibration of 

the gas analysers and the ventilation measurement system (Chapter 5.2). It is recommended 

to calibrate the device before conducting a series of examinations on a given day.  
During the examination the only command available is the one ending the examination 

(the Stop command from the Examination menu). It prevents all incorrect methods of 

ending the work with the programme (e.g. closing the programme during the examination). 

The whole examination may summarised in the following points:  
 

1. Control the device for safety from electric shock checking visually the condition of 

the electric cables.  
2. Perform the everyday device service according to the guideline from Chapter: 

Maintenance and everyday service. 
3. Turn the device on with the use of the mains switch at the back of the device (W1 

switch in Ill. 1). 
4. Leave the device on for at least 30 minutes so that the measurement elements would 

gain the thermal stability. 
5. Start the Start 2000/Finder programme. 
6. Enter the patient's data ( Chapter 4). 
7. Match the proper size of the measurement mask for the patient so as to ensure the 

tightness on the contact point with the skin of the face.  
 

NOTE! 
A/ It is recommended to connect the pneumotachographic head to the mask before 

putting it on; 
B/ One should remember not to connect the pneumotachographic head connection 

cable before the automatic zeroing procedure of the measurement system is 

completed; 
8. Set the examination options ( Chapter 5.3). 
9. Start the examination by clicking the B icon ( Chapter 7.2.1). 
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10. Conduct the examination according to the description of this type of examination.  
11. Finish the examination with the Stop button (button with the red circle). Save the 

examination ( Chapter 7.3).  
12. In order to conduct another examination, one should close the open examination 

(the Close command in the File menu). Further procedure goes as described above 

starting from point 3. The patient's data refer to the last patient. When the 

examination is conducted on another patient, the data should be modified ( 

Chapter 4.2).  

7.2.1. The Test for VO2max Finder examination. 

This examination is started by clicking the B button or selecting the Test for Start 

2000 command from the Examination menu. Obviously, one has to enter the patient's data 

first ( Chapter 4) and set the programme options ( Chapter 5). If the programme's 

calibration is invalid, it will require the calibration of gases and volumes. Such calibration is 

valid for 24 hours. The same is true for the environment conditions. The measurement 

system is ventilated automatically – 'Ventilation of the measurement system' presented with 

the help of progress bar. After the ventilation is finished, the system asks whether it should 

zero, then after pressing OK, there is the zeroing conducted – also presented with the help 

of progress bar.  
 

NOTE. 
a/The pneumotachographic head connection cable cannot be connected to the 

pneumotachographic head attached to the mask; 
b/It is required to move the pneumotachographic head connection cable as far away 

as possible from the mouth of the examined person or the person operating the 

ergospirometer!  
c/After the zeroing is completed, the measurement system is in the control phase 

and then the pneumotachographic head connection cable should be connected to the 

head and the connection terminal in the mask; 
If the last update took place more then 4 hours before the attempt to start the test, 

the programme will remind about the data update ( Chapter 5.1). When this type of 

examination is selected, the programme menu and toolbar changes. The toolbar is presented 

in Ill. 32. 
 

 

Ill. 32. Toolbar for the Test for VO2max Finder examination. 

The test is started wen the Start command from the Examination menu. Depending 

on the examination option settings, the programme goes to the control stage of the 

examination ( Chapter 6.1) or requires entering the examination phases ( Chapter 6.2). 

After entering the phases, the examination should be started once again. If the programme 

operated correctly in the control stage, we may go to the examination stage by clicking the 

GO icon or selecting the Start test command from the Examination menu. The control stage 

for the 1.6.0.0 version could last maximum of 5 minutes. From the 1.6.0.0 version it is 

unrestricted, but every 5 minutes a reminder is displayed that we are in the control stage. In 

this time is exceeded, the programme informs about this fact and recommends starting the 

examination from the beginning. In the examination stage the diagram views and tables 

with parameters are zeroed. If the examination is conducted with the use of a controlled 

ergometer, the control is initiated. Ergometer control can be done on the basis of the 
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examination project phases or with the help of remote control. The remote control is 

launched with the Ergometer control command from the Examination menu or by clicking 

on the remote control icon in the toolbar. Operating the remote control is described in 

Chapter 6.4. During the examination the ergospirometer pumps are working. Should the 

need arise they can be turned on and off with the Pumps On/ Off command (Examination 

menu) or with the pump button on the toolbar.  
 During the examination in the diagram views there are drawn the on-line courses 

and diagrams of parameters selected in the reference menu of the diagram view ( Chapter 

6.5.1.2). The values of individual parameters are entered to the table in Examination options 

-> Document view ( Chapter 5.4.1). One may also set there the number of diagram views. 

During the examination with the set phases and controlled ergometer, in the status line there 

is entered information about the number of all the phases, the number of the current phase 

and the time left to the phase completion, and the time left to the test completion. The 

examination is stopped with the Stop command from the Examination menu. One should 

then save the conducted examination to file  ( Chapter 7.3). The programme saves the 

diagrams and table columns for all parameters, irrespective of which and how many 

parameters we have selected to be drawn on the diagram and in the table. It means that after 

opening the examination from the file, we have access to all diagrams and values of all 

parameters from every moment of the examination.   
 

 

7.2.2. Spirometric examination. 

Selectin the Spirometric examination command from the Examination menu 

launches the LungTest 1000 programme with the previously entered patient data. The 

LungTest 1000 programme is described in a similar manual. 

7.2.3. Download parameters LT. 

After the selection of this command, a dialogue window appears as presented in Ill. 

33. 
 

 

Ill. 33. Spirometric examination parameters.  

 

In the left column there are names of examinations to be conducted to obtain the parameters 

from the middle column. In order to conduct a given examination, one should press the 

Conduct button. The LungTest 1000 programme is then launched in the mode suitable for 
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the given examination. One should conduct the examination and the desired parameters will 

be transferred to the programme.    
 

7.2.4. Examination with stabilisation (OPTION). 

During this examination we stabilise the parameters of the inhaled gas. Depending 

on the fact whether we select oxygen stabilisation or air stabilisation in the options, the 

stabilised parameter will be the oxygen concentration in the inhaled gas or the temperature 

and humidity of the inhaled gas. Both the gas concentration and temperature are set in the 

examination options (Chapter 5.4.3), while the humidity should be kept at the level of 40 – 

50 %. In order to start the examinations, the system requires valida calibrations. They are 

valid for 24 hours. It refers to the calibration of the oxygen and carbon dioxide sensor for 

the gas analysis from the head, and the oxygen sensor for the analysis of inhaled gas (from 

the bag). One should pay attention to the fact that the examination with oxygen stabilisation 

uses another oxygen sensor for gas from the head than the standard examination. Its 

calibration is conducted with the Gas calibration (high O2) command (Chapter 5.2.3). 

Calibration coefficient for carbon dioxide calibration is the same for both types of 

examination. Please, mark the System with three-way valve option in the General tab in the 

Examination options for the examination with stabilisation, because the breaths go through 

this valve.    
The examination starts with entering the patient's data and selecting the Start 

command from the Examination menu. There appears information that 'zero' will be read 

from the atmosphere for the oxygen sensor in the bag and the request for taking the bag off 

the device. After acceptance, 'zero' is read from the atmosphere (it is the reference level for 

the oxygen sensor). Then the system informs about the intention of filling the bag with the 

gas mixture and requests for the bag to be attached to the device. After pressing Yes there is 

the preliminary filling of the bag with the gas mixture. Depending on the fact whether the 

examination is conducted with the oxygen stabilisation or the air stabilisation, the system 

fills the bag either with the mixture of oxygen and air of set concentration or with air of set 

temperature and humidity lower than 50 %. The filling time depends on the flows set in the 

examination options and on the volume of the initial mixture which is also set in the 

options. During the filling the information progress bar moves and the total time of filling is 

given. 
 

When the bag is full, the starting procedure for the examination is the same as for the Test 

for VO2max Finder examination. There is a question about the measurement system 

zeroing, ventilation, system zeroing, checking the zero and examination start.   
 In the examination with stabilisation we have at our disposal three more parameters 

in the table. They are: O2 concentration, temperature and inhalation gas humidity. They 

allow to assess the stabilisation quality. During the examination the bag is filled 

automatically with the inhalation gas. In order to turn the filling system off for any reason, 

one should de-mark the Filling system field in the Tools menu or press the    button on 

the toolbar. Additionally, after the examination is properly completed, we have a printed 

report summing up the examination. It includes information about the stabilisation type, and 

in case of oxygen stabilisation also the date and calibration coefficient for the oxygen 

sensor in the bag. The report also includes the parameters set for stabilisation and the 

obtained parameters +/- standard deviation. One should pay attention to the fact that for the 

examination with oxygen stabilisation the coefficient and date of O2 calibration refers to 

calibration with high oxygen.   
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7.3. Saving the examination to file. 

In order to save the examination results, select the Save examination command from 

the File menu. There appears a dialogue window with the question about the name of the 

file where we would like to save the examination. Standard extension of these files is *.egs. 

The programme creates automatically a subdirectory with the patient's personal data in the 

proper directory set in Examination options ( Chapter 5.3.3). The file name consists of the 

date and time of conducting the examination. We may obviously change the name of the 

file and the directory where we want to save it. The file is saved upon closing the Save 

dialogue window with the OK button. If we try to close the programme without saving, the 

programme will remind us of the fact that the examination is not saved and enable us to 

save the examination before closing the programme.   

7.4. Opening examination from the file. 

The programme opens one type of files with the *.egs extension which include the 

saved examination. The examination saving process is described in chapter 7.3.  In order to 

open the desired file, one should select the Open command from the File menu. When the 

dialogue window appears, select the file that we want to read.   
Upon opening the programme displays the diagram views and table with the parameters for 

the individual moments of examination. The number of views is set in Examination options 

-> Document view ( Chapter 5.4.1). The parameters displayed in the table are determined 

in the table view options ( Chapter 6.5.4). Because the values of all parameters from 

every moment of the examination are saved to the file, we may put any parameter in the 

table or on the diagram. In this way we have access to the diagram of every parameter and 

to its values at any moment of the examination.     

7.5. Printing the examination report. 

We may print the examination results after the examination completion or after 

opening the examination from file ( Chapter 7.4). In order to print a report, one should 

select the Print command from the File menu or click on the printer icon in the toolbar. In 

order to survey the report layout, one should select the Printout preview command from the 

File menu. The printout may be set with the Print settings command from the File menu. 

The parameters of report layout may be set in Printout configuration. Its description can be 

found in chapter 7.5.2.  

7.5.1. Print settings. 

The Print settings command from the File menu launches the menu where we set 

the printout parameters. Here those parameters include: type of the printer with which we 

want to print the report, size and source of paper, page orientation. This window is 

presented in Ill. 34. 
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Ill. 34. Print settings dialogue window. 

7.5.2. Printout configuration. 

The layout options of the examination report are set in the window that appears after 

selection of the Printout configuration command from the Examination menu. It is 

presented in Ill. 35. 
 

 

Ill. 35. Printout configuration dialogue window. 

In the Name of institution fields we enter the name of institution that conducted the 

examination. The name will appear under the heading on the first page of the report ( 

Chapter 9). By marking the Colour printout field we inform the programme whether the 

printing will be in colour or not. If we do not mark this field, the programme will treat it as 
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printing in the grey scale. In such case every view with more than one diagram will be 

divided into so many separate diagrams as there was parameters determined in this view. 

Every selected parameter will be printed on a separate diagram. In the Number of diagrams 

on page field we determine how many diagrams should there be on one printout page. We 

confirm the set parameters with the OK button.  
In the Configuration field we select the printout elements. The maked modules will appear 

on the final printout. The buttons: 9 landscape report AT/CPET  and Additional diagrams 

AT/CPET are used for the AT/CPET report configuration (Chapter 9) . 
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8. Mode of searching the AT threshold. 

In order to go to the mode of searching the AT threshold one should select the AT 

search command from the Tools menu or select the  from the toolbar. As a result the 

system displays three windows. 

 

Ill. 36. View of the mode of searching AT. 

They display the value data of the examination parameters from the exertion phase (except 

for the first window which displays the data from the whole examination and the exertion 

area is marked with two orange vertical lines). The first window includes the diagram of 

maximum of four parameters in time. Those parameters may be selected freely in the same 

way as in the case of ordinary diagrams (the Parameters command from the diagram 

menu). The second window is the diagram of the relation of VCO2 and RER to VO2 

parameters. The third window displays one of the prepared parameter sets which is selected 

from the diagram menu (Parameters command). There is also a table displayed which, 

contrary to an ordinary table, has an orange heading. Upon selecting the AR search 

command the system automatically starts to search for the point closest to the AT threshold. 

In order to do this the programme uses the MES algorithm. If the threshold is determined, it 

will be marked on the diagrams and in the table. If the algorithm fails to determine the point 

corresponding to the AT threshold, the user will be informed about this fact.  
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If we want to determine the AT threshold on own own, the mode of searching the 

AT threshold offers us a lot of facilities. On the first diagram we have at our disposal an 

indicator (a vertical line) which we can move horizontally (along the time axis) with the 

mouse cursor (the indicator 'sticks' to the mouse cursor when the cursor moves onto the area 

of the first window). Moving the indicator within the exertion phases' area (two orange 

vertical line – only when the grid is displayed) on the second diagram the two regression 

straight line change their positions. They refer to the two data areas. Those areas are created 

by splitting all the data with a point marked with the indicator in the first window. The 

regression lines facilitate finding the maximum inflection point of the VCO2 in relation to 

VO2 diagram (point suspected of being the AT). Apart from the regression lines in the 

second window there is also an indicator (vertical line) drawn that determines the point 

corresponding to the place indicated in the first window. Such indicator is also drawn in the 

third window. Additionally, while moving the indicator, in the table there is marked in light 

orange a row corresponding to the indicated place. Also the table scroll is moved 

automatically so that the indicated row is displayed in the visible fragment of the table. In 

order to identify the place in the first window more accurately we can turn on the scroll. We 

do this as with the ordinary diagrams through double click on the area. We can turn the 

scroll off in the same way. With the indicator's movements there is integrated information 

about the phases displayed in the status bar. Hence we know in which phase the indicator is, 

how long it lasted and what the exertion was then. 

Both the first and third view can undergo configuration. For the first one we select 

the parameters like for the ordinary diagrams (the Parameters command from the view 

menu). For the third one the call is also made with the Parameters command, but here there 

will be displayed a window with parameter sets (like for the configuration, e.g. 9 landscape 

AT/CPET report). From this list we select one set of parameters.   

In order to mark in the chosen place the AT point, we select from the menu of the 

first view the Insert AT threshold command. The place is marked with an orange dashed 

line on every diagram and in the table the row is highlighted in orange. Additionally, on the 

second diagram the regression line of the first data area (data are split by the AT threshold) 

is drawn with this orange dashed line. The determined AT threshold is also marked in the 

table by highlighting the row in orange.   

After determining the AT threshold, we may print the report referring to this 

determination. In order to do this we mark the AT/CPET report option in the printout 

configuration. In order to print additional report diagrams one should also mark the 

Additional AT/CPET report diagrams button. The window is identical as for the 9 

landscape AT/CPET report (Ill. 37). We select there two to four parameter sets. The sets for 

the 9 landscape report are selected after launching the window with the 9 landscape 

AT/CPET report window. During the 9 landscape report one needs to select nine sets.   
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Ill. 37. Configuration of the 9 landscape AT/CPET report. 

Detailed description of the report from determining the AT threshold can be found in the 

next chapter: Examination report (Chapter 9). 
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9. Examination report. 

 

Ill. 38. Examination report. 

The user can decide the range of the printed report. According to chapter 7.5.2 and 

dialogue window in ill. 35, there is a possibility of report standard configuration for the 

user's purposes.  
The first page of the sample examination report is presented in Ill. 38. Under the 

heading with the MES company logo as well as the ergospirometer name and the conducted 

examination, there is the name of institution that conducted the examination (if it was 

entered in the Printout configuration – Chapter 7.5.2). Underneath there are data of the 

examined patient and the examination date. Then there are printed all the diagrams 

displayed in the diagram views. In case of black-and-white printout the views with more 

than one diagram are divided so that one view included only one diagram. After the 
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diagrams there is the table drawn. If it exceeds the available width of the printout, on the 

pages dedicated to the table there is a message: Too little space to print the table. Then one 

should reduce the number of parameters in the table ( Chapter ). Before starting to print, 

it is recommended to check the printout preview (the Printout preview command from 

the File menu). In the report's footnote there are the parameters referring to the 

atmospheric conditions during the examination and information about the last gas and 

volume calibrations before the examination. ( Chapter 5.2).   
After the diagrams the table may be printed (Ill. 39). It looks the same as in the 

programme window. 
 

 

Ill. 39. Table on the printout. 

 

 

After the table there may be an additional report on the printout (Ill. 40). 
 



Operating manual for VO2max Finder system 
. 

 

 59 

 
 

Ill. 40. Additional report(PL). 
 

Additional report includes the spirometric parameters valid for the given patient on the 

examination day, the maximum values for which norms apply (together with the norm 

values and percentage of deviation), the parameter values in the anaerobic threshold point, 

parameters of the oxygen debt and the name of programme phases if they were loaded from 

the file and not entered manually. If there are no spirometric parameters, suitable 

information will be placed there instead of them. Similarly in case of the oxygen debt if it is 

not calculated, there will be information displayed about the likely cause for this state of 

affairs. Usually, it is the lack of any phases in the examination. The parameters for which 

the maximum value norms apply are VO2, HR, BR, VE. 
 

Then there may be a metabolism report. The detailed description of it can be found in 

chapters .(Chapter 6.15) and .(Chapter 6.16). 

 

Then there may be a commentary to the examination (Ill. 41) and chapter .(6.17). 
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Ill. 41. Commentary on the printout. 

 

The next pages are the printout related to the AT threshold determination. Below there is 

the first page presented. 
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Ill. 42. First page of the AT/CPET report. 

 

The first page of the report includes the cause the test termination, the spirometric 

parameters and average values of some parameters from the rest phase, maximum values 

from the exertion phases and values of the AT threshold. The window with the cause of test 

termination appears at the end of the examination if the proper option was marked in the 

Examination options. Additionally, this window may be displayed with the Cause of test 

termination command from the Tools menu. The cause of test termination is saved with the 

examination. Additionally, the table includes the SBP, DBP, Borg and lactate (Lct) 

parameters. The window to enter those values appears automatically during the examination 

when there is a phase change if the proper option was marked in the Examination options. 

One may call the window individually with the Enter SBP/ DBP/ Borg command from the 

Examination menu or clicking on the icon: . 
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Ill. 43. AT report – 9 diagram view 

The second page may include nine diagrams selected from among twenty/ 

seventeen. The selection is made in the Printout configuration menu by clicking the 

Configuration of 9 view AT report button. From the displayed menu we mark 9 selected 

diagrams. 

 

 

 

 

 

 

 

On the third page of the report there are two views: V-Slope AT  
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and  Dual Criteria AT. The first one presents the diagram of VCO2 in relation to VO2. 

 

Ill. 44. Third page of the AT/CPET report. 

It is the same diagram as the second diagram of the mode of searching AT, but here 

we do not have the RER parameter. The second view is the diagram of the parameters: 

EqO2, EqCO2, PeO2 and PeCO2 in relation to VO2. In those views there are additional 

columns with the expected range (light orange), the AT threshold is marked with an orange 

vertical line and the VO2 maximum value norms are displayed. On this page there are laso 

tables. The first one includes the percentage values of the VO2 parameters in the AT point 

in relation to the VO2 maximum value from the exertion phases and in relation to the VO2 

due. The second table is split to groups: metabolism, ventilation and gas exchange, 

parameter values in the AT points. If the AT threshold was not selected, the table will not 

appear and the Determined AT threshold caption will change into No determined AT 

threshold. On the next pages there may be additional diagrams selected in the printout 

configuration.  
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Ill. 45. Additional diagrams of mode of searching the AT. 

We may print individual views in Mode of searching the AT. In order to do this, one should 

select the Print diagram command from the menu of the selected diagram view.   
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10. Menu commands. 

10.1.  File menu 

Patient's data  Chapter 4 

Open...  Chapter 7.4  

Close Closes the opened examination. 

Save   Chapter 7.3 

Save as .. Saves the examination result under the set name. 

Print...  Chapter 7.5  

Printout preview  Chapter 7.5 

Printout settings...  Chapter 7.5.1 

Printout configuration...  Chapter 7.5.2 

List of the recently opened files Includes the list of the recently opened files.  

Finish Ends the work with the programme 

10.2.  View menu. 

 

Toolbars Shows or hides the toolbar. 

Status line Shows or hides the status line ( Chapter 11.3). 

Data averaging...  Chapter 6.6 

Parameters displayed in the table.  Chapter 6.5.4 

ECG parameters  Chapter 0 

Configuration of BMR norms  Chapter 6.15 

Calculate calorimetry  Chapter 6.16 

Stretching the Y diagram  Chapter 6.5.2.1 

Narrowing the Y diagram  Chapter 6.5.2.1 

Stretching the X diagram  Chapter 6.5.2.1 

Narrowing the X diagram  Chapter 6.5.2.1 

Default range of X scale  Chapter 6.5.2.4 

Synchronisation of diagram with 

the table 
 Chapter 6.5.4.6 

Synchronisation of table with the 

diagram 
 Chapter 6.5.2.2 

Synchronisation of diagrams with 

the diagram 
 Chapter 6.5.2.3 

Pop-Up window  Chapter 6.5.4.5 

10.3. Examination menu. 

Test for VO2max Finder  Chapter 7.2.1 

Test with Stabilisation  Chapter 7.2.4 

Spirometric examination  Chapter 7.2.2 

Start Starts the examination ( Chapter 7.2). 

Stop Ends the examination ( Chapter 7.2). 
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Start the test Starts the examination stage ( Chapter 7.2). 

Enter event Enters event 6.3 

Edit event  Chapter 6.3 

Examination phases...  Chapter 6.2 

Ergometer control  Launches the remote control to control the ergometer ( 

Chapter 6.4).  

Commentary  Chapter 6.17 

Enter SBP, DBP, Borg, Lct 
 

 Chapter 8 

10.4.  Tools menu. 

Gas calibration   Chapter 5.2.2 

Volume calibration  Chapter 5.2.1 

Flow zeroing  Chapter 6.7 

Gas zeroing  Chapter 6.7 

Environment conditions  Chapter 5.1 

Equipment configuration  Chapter 5.3 

Examination options  Chapter 5.4 

Export to text file  Chapter 6.8 

Last parameters LT  Chapter 6.9 

Show dues  Chapter 6.10 

Print table  Chapter 6.5.4.7 

Determine AT threshold  Chapter 6.13 

Remove AT threshold  Chapter 6.14 

Cause of test termination  Chapter 5.4.2 

10.5. Help menu. 

About the 

programme  
Displays information about the programme: version number, copyright, 

etc.  
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11. Toolbar. 

11.1. Standard toolbar. 

 

Ill. 49. Toolbar 

This toolbar includes the following buttons: 
 

 
Test for VO2max Finder Starts new examination ( Chapter 7.2.1) 

 
Examination with Stabilisation Starts examination with stabilisation ( Chapter 

7.2.4) 

 
Spirometric examination  Chapter 7.2.2 

 
Open  Chapter 7.4 

 
Save   Chapter 7.3 

 
Printout preview  Chapter 7.5 

 
Print  Chapter 7.5 

 
Export to statistical programmes  Chapter 6.8 

 
Volume calibration  Chapter 5.2.1 

 
Gas calibration  Chapter 5.2.2 

 
Atmospheric conditions  Chapter 5.1 

 
Flow zeroing  Chapter 6.7 

 
About the programme  Displays information about the programme: 

version number, copyright, etc. 

 
Stretching the Y diagram  Chapter 6.5.2.1 

 
Narrowing the Y diagram  Chapter 6.5.2.1 

 
Stretching the X diagram  Chapter 6.5.2.1 

 
Narrowing the X diagram  Chapter 6.5.2.1 

 
Default range of X scale  Chapter 6.5.2.4 

 
Synchronisation of diagram with the 

table 
 Chapter 6.5.4.6 

 
Synchronisation of table with the 

diagram 
 Chapter 6.5.2.2 

 
Synchronisation of diagrams with the 

diagram 
 Chapter 6.5.2.3 

11.2. Toolbar of the Test for VO2max Finder examination. 

 

Ill. 46. Toolbar of the Test for VO2max Finder examination. 
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This toolbar includes the following buttons: 
 

 
Open  Chapter 7.4 

 
Save   Chapter 7.3 

 
Print  Chapter 7.5 

 
Export to statistical programmes  Chapter 6.8 

 
Start Starts the control stage ( Chapter 7.2) 

 
Start test Starts the examination stage ( Chapter 7.2) 

 
 Stop Terminates the examination ( Chapter. 7.2) 

 
Enter event Enters event (Chapter  6.3) 

 
Ergometer control  Launches the remote control ( Chapter 6.4) 

 
Move to the last phase  Chapter 6.4 

 
Turn on/ off the pumps  Turns the pumps on and off 

 
Atmospheric conditions  Chapter 5.2.2 

 
Flow zeroing  Chapter 6.7 

 
Gas zeroing  Chapter 6.7 

 
About the programme  Displays information about the programme: 

version number, copyright, etc. 

 
Filling system  Chapter 7.2.4 

 
Stretching the Y diagram  Chapter 6.5.2.1 

 
Narrowing the Y diagram  Chapter 6.5.2.1 

 
Stretching the X diagram  Chapter 6.5.2.1 

 
Narrowing the X diagram  Chapter 6.5.2.1 

 
Defaulf range of X scale  Chapter 6.5.2.4 

 
Synchronisation of diagram with the 

table 
 Chapter 6.5.4.6 

 
Synchronisation of table with the 

diagram 
 Chapter 6.5.2.2 

 
Synchronisation of diagrams with the 

diagram 
 Chapter 6.5.2.3 

 
Pop-Up window  Chapter 6.5.4.5 

 
Mode of searching AT  Chapter 8 

 
Enter SBP, DBP, Borg, Lct  Chapter 8 

11.3. Status line. 

The status line is at the bottom edge of the main application window ( Ill. 47). Its 

position cannot be changed, however, the line may be hidden with the help of the Status line 

command (View menu). 
The status line displays explanations of menu commands and elements in the 

toolbars. In order to obtain the explanation, one place the mouse cursor upon the given 

element. 
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During the examination with the use of ergometer control the line displays 

information about the number of all phases, the number of the current phase, phase duration 

time, time left to the end of the phase and time left to the end of examination.   
On the right of the status line there are three fields informing about the status of the 

following keys: CapsLock, NumLock and ScrollLock. 

 

Ill. 47. Status line. 
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12. Maintenance and everyday service. 

1. Replace the content of the humidity absorber in the back part of the device after 

every hour of the device's work.  
2. After the finished work, remove the content of the tank from the humidity 

absorber.  
3. Before starting the examination and device calibration fill the tank of the humidity 

absorber.  
4. As the humidity absorber use the globule agent of the silicon gel. If the gel 

contains the colourful indicator, it should be blue before the humidity absorption 

and pink afterwards.  
5. Check the system of sponges at the outlets of the connection terminals of the 

humidity tank – they should be clean. The sponges can be cleaned in water and 

dried.  
6. Sponges in the humidity absorber tank should be always placed at the outlets of 

the connection terminals. 
7. The devices cannot be started without the sponges in the absorber tank.  
8. The masks always have to be clean, and the mask's channel – connected with the 

air cable – must be patent. 
9. The masks and the pneumotachographic heads should be changed after each 

examination so that the patient would receive sterile mask and head.  
10. The mask and mouthpiece sterilisation can be done in the gas steriliser or in 

liquids (CIDEX or ALDESAN). 
11. Sterilisation in liquids should be done through dipping the masks for 2 hours and 

then carefully washing them with distilled water and drying. The drying 

temperature cannot exceed 65C. 
12. After sterilisation in liquids and drying, the masks and heads should be checked in 

terms of the patency of the air channels.  
13. Grounding and potential levelling connections: VO2max Finder is a device 

with the B2 anti-shock protection class. The device's grounding is not necessary, 

but it may be helpful in removing the interferences from the mains supply. The 

supply cable is equipped with the neutralising cable (the central pin in the port and 

plug of the supply cable). If the supply mains neutralisation is uncertain, then it is 

possible to connect the device to grounding in compliance with the IEC norm with 

the help of the grounding cable. The grounding cable should be connected to the 

device with the help of the grounding port on the back board of the device. Note. 

The grounding cables are not the potential levelling cables.  
14. Fuse replacement. Fuse of 1A 220V 50Hz is placed in the drawer port of the 

supply switch on the back board of the device. In order to replace the fuse, one 

should unplug the supply cable and then take out the fuse drawer. Note. One 

should only use fuses with parameters as given in the manual. 
NOTE!!! 
The above recommendations should be strictly followed! 
Non-observance of the above recommendations may damage the device, 

lead to erroneous results of the conducted tests and to  infect the 

examined person.  
 


